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EXCEL
To audit your Excel spreadsheet, copy it, replace all entries (cells) with the figure 1. Do not enter anything in blank cells or in formula cells.  
Print out. Now replace figures in either row or column 2 with the figure 2, in row (or column) 3 with 3, 4 with 4, and so on.  Print out.
Using a pocket calculator, you can now quickly find errors in your formulas and in the concept of your spreadsheet. (MacNexus, Sacramento, CA, 
MUG)

You can change Imagewriter quality to Best in Excel with a Command/B keystroke.

To go right to Preview in Excel, use Command/P, which saves a trip through the dialog box.

To set left and right borders on selected cells in Excel, select the leftmost cell, type L, select the rightmost cell and type R.

MACDRAW
Is your finger tired holding down the Option key in MacDraw while drawing polygons?  Use a plastic paperclip to jam the Option key in a down 
position.  To end the polygon, remove the paperclip to release the Option key and double-click.

If you need to scroll in Mac Draw while drawing a polygon, here is a way:
Make a false start by placing two points of a poolygon while holding down the Command key. Double-click to end this "polygon." Your polygon 
tool should still be selected, so be sure to keep holding down the Command key. Use the paperclip trick (jam the key down with a plastic  
paperclip) to keep it down.
Now begin another polygon near the bottom of the screen. Place points as high on the screen as you need them, and come back down.  When you 
reach the bottom of the screen, release the Command key.
The polygon will appear to be closed and the pointer tool will be selected.  Don't panic now!!! Both the polygon you and the tool are still active.  
This is a MacDraw bug which you can use nicely.
Go to the scroll bar and scroll down until the bottom of the original screen is now near the top. You must be able to see the first point you made  
on screen.
Place the tip of the pointer below the polygon symbol in the tool palette and click. The polygon will abruptly activate itself. You can now continue 
your polygon ending at the point where you originally began.
Unfortunately, you cannot repeatedly extend the shape. One break per polygon is all you get. When you are through, delete the false start polygon 
you made.
The same technique works with a horizontal scroll or a diagonal scroll. Just be sure to begin the polygon as close to the joining edge of the  
screens as you can.
Be sure you Save before attempting this.  You are working with a MacDraw bug on purpose, so play it safe. (Tom Mosler, The News and  
Observor, Raleigh, NC, as printed in DeadlineMac)

Color graphics printing masters are easy in MacDraw. Ask Dan Clifford, 305-376-3422, because Dan does it all the time.

To measure in pixels in MacDraw, use Custom Rulers. Set minor divisions at 6 to the inch. Chanbe Numbering Increments to 6 (this converts the 
ruler to show pica divisions). Click OK. Choose 12 minor divisions for 6-point grid increments or 24 minor divisions for 3-point grid increments.

Keep MacDraw objects in proportion while stretching them by drawing a line from the upper left corner diagonally through the lower right  
corner. Continue this line far enough to accommodate the enlarged image.
Now grab the lower right corner of the image and drag it carefully along the line to retain proportion.  When you are satisfied, delete the line.
Also, try selecting a handle first, then holding down Shift.  This also causes MacDraw to enlarge (or reduce) proportionally.

You can make cropping L's in MacDraw using the polygon tool. 

If you lose the backmost smoothed polygon when printing Mac Draw files on the LaserWriter, place a "throwaway" no fill, no border polygon  
behind the backmost polygon.  Let the LaserWriter chew away on that instead of your valuable work. Don't smooth this throwaway polygon.

To keep a polygon from closing prematurely in MacDraw, hold the Option key down whle placing points close to each other.

Do you know how to "cusp" in MacDraw? To cusp, or make a sharp point which will not round out during smoothing, place two points on the 
same spot. When you smooth the polygon, this point will remain a point. Cusps will not show a handle in the reshape polygon mode.

Are you waiting for MacDraw to redraw the screen? Smoothed polygons make MacDraw redraw painfully slowly. Develop your shape, smooth  
the polygon, and when satisfied, unsmooth it.  Do the same for each smoothed polygon.  When you are almost ready to print, run around and 
smooth each one.
The idea is to do most of your work with NO smoothed polygons on the screen.



Smoothed MacDraw polygons with more than 150 points may refuse to fill with a pattern.

Too many MacDraw smoothed polygons stacked on top of each other may cause a PostScript printing error.

MS WORD
To scale graphics in MS Word, use Command/Shift/Y, followed by a number between 0 and 9.  1-9 keys give you 10% through 90% reduction.  
The 0 key returns you to original size.

Another handy way to format text in MS Word 1.05 is to keep a couple of short examples just below the cursor.  For instance, a line of 10 point  
bold Helvetica centered, and a line of indented 10 point Times. When you need to use these formats, highlight the copy to be changed, then hold  
down Command/ Option and click on the line of copy for font and style changes, and click at the left edge of the screen next to the line for  
paragraph formatting changes.

To select from the insertion point to the end of a document, press Option/Command/Shift and then type quote/period.

MS WORKS
MS Works becomes super productive when you add a handful of Tempo or AutoMac macros.

LASERWRITER
For acetate overlays from the LaserWriter, manually feed 3M-503 Clear Acetate sheets.

For crisper LaserWriter printouts, draw at double size and print out at 50%. Don't forget to double the size of your type, though, or it may be 
unreadable, or out of scale.

To execute PostScript code from within an application, modify LaserWriter drivers 3.1 and above.  Open ResEdit, find STR# -8188. Change 
<PostScript Escape> to an existing font name, such as <Chicago> or use ResEdit to change a font's name to <PostScript Escape> Install this  
modified LaserWriter icon in your System Folder.  The < and > are used above to isolate changes you need to make.  Do not type them.  
(MacinTalk, Nashville, TN MUG)

Is your Helvetica spread out when you print it on the LaserWriter?  Open ResEdit, Open System, Open FOND (not FONT), Open Helvetica  
ID=21. Scroll to ExtraWidth for Bold. Change $0155 to $0000. Close by using Quit from the File menu.  Say yes when asked if you want to save 
the changes. Do not change ExtraWidth for Outline (in case you were thinking of doing that), because that will crowd the Outline text. (Deadline  
Mac)

GENERAL
Nice shadows are easy.  In MacPaint, FullPaint, SuperPaint, Mac Draw, Mac Draft and other programs, lasso and copy or duplicate the object.  
Shade the copy black. Pull the original on top of it until just the right amound of shadow shows at the bottom and one side. Group them if you are  
in an object-oriented program. 

Don't know where to get it? One of the truly mammoth collections of Macintosh software is stocked by ComputerWare, 415-323-7557. User  
groups report that they are reliable, unlike some mailorder outfits.

Multiple, consecutive, global font changes in MacWrite can bomb. Save between each such global change.

PICT images imported to Pagemaker from MacDraft 1.2a disappear at 200% view. Only the text will show.  But it will print out OK. To see 
everything at  200%, take it  to  MacDraw, save it  as  a  PICT file  with ANOTHER NAME. Take this  MacDraw PICT file  into Pagemaker.  
Everything will look OK (Thunder Enlighening, Thunder Bay, Ontario, MUG)

If your Imagewriter II prints too lightly, take it to an Apple dealer and tell them you want Apple part #955-0005, a $1.00 shim, installed.  
Negotiate the labor cost before you jump in.

You can make a switching icon. A switching icon is one that looks totally different when clicked on.  For instance, MacBackup displays a  
cracked egg for an icon. When you click on it, a baby chick hops out of the egg.
Make your two icon versions (the unclicked on and the clicked on) in MacPaint or FullPaint. Be sure it fits within a 32x32 pixel square. When 
you are satisfied, place a pixel in each of the four corners of the 32 pixel square.  You will need these for reference.
Now Copy and Paste each icon into a separate Scrapbook page.
Open ResEdit. Open ICN#. Go to the File menu and select New. When you are in the editing window (the one with two large screens to build  
icon and mask in), go to the Scrapbook and Copy the "before clicking" icon. Paste this into the left side of the editing window.
Now go to the Scrapbook and Copy your "after clicking" icon. Paste this into the right side of the editing window.
Next, do a screen dump (Command/Shift/3) of the entire editing window including the small images across the bottom of the editing screen. Exit 
ResEdit, saving your changes.
Open the screen dump in MacPaint or FullPaint. Place a selection rectangle tight around the second image from the left at the bottom of the 
screen. Be sure this rectangle includes the four corner pixels.
Reenter ResEdit. Go to the editing window. Go to the Scrapbook and Copy the image. Paste this into the righthand portion (mask) of the editing  
window. It will replace the previous image.
At all steps in this process, make sure the four pixels at the four corners are accurately placed.  That's what they are there for.
Now, if you are satisfied, remove the four corner pixels on each side (assuming they are not a part of your design. If they are a part of the design,  



leave them there.
Exit ResEdit, saving changes. You now have a switching icon.  Using other icon hacking tools, you can now place this icon in the application of  
your choice.

Does your Mac forget which printer is selected?  Check and see if your System is 3.2 or higher.  If not, this is probably your problem.  In an 
emergency, you can make your printer selection stay in place by moving to the Control Panel and making ANY CHANGE AT ALL. You can  
change it back once you have done this.  This lets your Mac know that you want to save the current setting in Chooser.

If you are in business renting Macs with software, tie the software disks to the Mac. Drill a small hole across from the write protect tab. Avoid  
getting any dust in the disk's innards. Use fishing line to tie the disk to the lock port on the back of the Mac, or to the table on which the Mac  
resides.

Teflon mouse feet  are only about $2, but if you want to save even that, use small negative (fuzzy) Velcro circles; the kind with the pull off  
adhesive backing. Place these feet on the two front corners of the mouse.

Do you have games which don't work with the Mac Plus? Make a bit copy (with CopyIIMac or MacBackup). Using FEdit or MacSnoop, change  
$7A700 to $3FA700, change S72700 to $3F2700, and change $7FD00 to $1FFD00.

Want to screen dump with a menu pulled down with the new ROMs? Use the desk accessory, Camera. It lets you set a 5 second (or more) pause  
before the screen dump takes place.  This gives you time to pull down a menu.  Wait for a beep (the dump is starting) and a double beep (the  
dump is finished) before letting go of the menu. Camera also lets you hide the cursor if you wish.

Power supply problems? It is said that the Macintosh Plus, bought new, has a sturdier power supply than a 128 or 512k machine, upgraded to a  
Plus. Caveat emptor.

Use Shutdown to properly exit your Mac with a hard disk attached.  This method will speed subsequent booting.

For a hurry up copy of several files, make a New folder, place all the files in it, and transfer the folder instead of the individual files.  It saves  
some time.

Is your Mac automatically booting you direct into an application?  Great if that is what you want.  If you don't, open the System Folder, click  
once on the Finder, go to  the Special menu and select Set Startup.  Your Mac will now boot to the Deskop.
To boot into an application, click once on the application of choice, go to the Special menu and choose Set Startup.

To leave your internal system in charge, even when you open an application on a disk with its own System Folder, Use FEdit or MacSnoop.  
Open the System you want to be in charge, find B678 0210 6738 and change it to B678 0210 6038.

Lose something in your Desktop window? Select By Name from the View menu and look for it alphabetically.

Finders 5.3 and up let you initialize balky disks by holding down Command/Shift/Tab while pushing in the disk.

For a fresh, clean start don't use the programmer's switch (front part). Shutdown instead. Using the programmer's switch bypasses the Mac's  
self-diagnostics, and does not clear out all memory.

Ever lose work because your Mac locked up and denied you access to Save under the File menu?  In programs with a keyboard equivalent for  
Save (like Command/S), you are in luck.  If not, why not use RedEdit to create a keyboard equivalent for Save? 

If you just dumped a database into MacWrite as a text file, setting appropriate tabs often restores the data into neat columns.  To facilitate this,  
insert a ruler just under the original ruler.  Now make all tab settings in the TOPMOST of the two rulers.  Next, remove the BOTTOM ruler, and  
all your tab settings will take place at once, saving you many minutes of waiting time.

The tab key moves you from box to box in most dialog boxes. Try different keystrokes in your dialog boxes to discover the keyboard equivalents  
which may be used to make selections in the dialog boxes.  Try combinations of Command/Shift/Option and Tab keys and see what happens.

Hewlett Packard 3-1/2" disks have a plastic projection near the metal shutter. This projection can hang your disk up in a Macintosh.  If you must 
use HP disks, carefully cut or file this projection off until the disk looks exactly like Sony and other Mac disks.

When you alter your System file, your Mac looks for empty space on the disk in which to store the alteration. Usually the space found by your  
Mac is not contiguous.  This means that your Mac has to hunt around in different places on the disk to perform otherwise simple operations.
To avoid this, create several dummy documents IMMEDIATELY after installing the system.  Call these System Growth 1, 2, 3 and so forth. Just a  
few small MacWrite files with a few k each will do.  Now when you want to make a change in the System, delete one or two of these files,  
starting with the lowest number (1). Now immediately make the System changes.  Your Mac will "find" the empty space and leave your System 
in one contiguous piece. 

MACDRAFT
If your Mac hangs up on MacDraft 1.2a fill patterns, or refuses to give you a no fill pattern, change the menu flash in the Control Panel to 1 
instead of 0. This is a bug, and they don't plan on fixing it, either.



SUPER PAINT
For easy 300 dpi bit-mapped graphics, draw your image in the bit map (paint) layer four times the desired size. Now send the image to the  
"draw" layer, choose Scale Drawing from Edit menu and specify 25%. Beautiful output. (MacValley Voice, Burbank, Calif. MUG)

RAM DISKS
The recommended RAM caching on a 2 meg Mac is to use TurboCharger 2.0d, and set default application size to 1024k. This is guaranteed  
space for your application. What remains in RAM cache. 
Select auto start. Choose customize from the TurboCharger menu. Select QuickQuit and Turbo Indicator. Set Appl. Mem. Adjust to zero. Select 
all drives for turbocharging. Choose Configure Application and Defeat QuickQuit at Launch if you will be using Omnis 3 Plus or MacDraft.  
(These ideas from Ken Peterson in Mouse Tracks from Portland MUG, Mrach issue. Ken recommends 2 megs, a hard disk and TurboCharger as 
the ideal combination for productivity on a Mac.)
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